
Opening or starting a movie project
To start working on a movie, you need to open a new or existing movie project. If you are just experimenting with iMovie and
don’t have video to use you can use the iMovie tutorial. Movies in iMovie are called projects because they are in an editing for-
mat, as opposed to a final viewing format such as Quicktime.

1. Connect your camcorder and turn it on. If you’re going to import digital video for your movie, connect and turn on your cam-
corder before opening or creating a new project. Otherwise, the new project may not be created in the camcorder’s video format.

2. Open iMovie and click new project if a dialog box appears, or choose file menu > new project.
3. Save the new movie (by clicking create) on the disk with the most available space. IMovie makes a movie project folder that

contains the movie file. All clips imported and edited in the movie are stored in the media folder in the movie folder.

Connecting a DV camcorder
IMovie is designed to work with devices that support the digital video (DV) format, such as a camcorder or deck, with a firewire
port.

To connect a DV camcorder, you need:
• a Macintosh computer with a firewire port.
• a camcorder or video deck with a firewire port.
• a 6-pin to 4-pin firewire cable.

To connect your DV camcorder to your computer with a firewire cable:
1. Turn off your DV camcorder.
2. Plug the 6-pin connector of the firewire cable into the 6-pin firewire port on your Macintosh.
3. Plug the 4-pin connector of the firewire cable into the 4-pin port of your DV camcorder.
4. Turn on your DV camcorder. If the camcorder does not turn on, it may not be set to the correct mode. If you are using a cam-

corder, set its power switch to VTR mode. If you are using a power supply instead of a battery, set the power adapter switch to
VTR/Camera mode to supply power to your camcorder. (If you set the switch to charge, your DV camcorder may not turn on.)
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Importing Video
To import digital video into your movie:
1. Make sure the mode switch is set to camera mode (C):

2. Use the camera mode playback controls to view the tape in the iMovie monitor.
3. Rewind the tape to a few seconds before the point where you want to start importing.
4. Click the play button.
5. When the iMovie monitor displays the scene you want to start importing, click the import button to begin importing.
6. To stop importing, click the import button again. You can also press the space bar on your keyboard to start and stop importing

video.

Preview the clips
1. When you bring your clips in they are placed on the Shelf (J). Click on one of the clips and click the play button (F) or press the

space bar to preview your clip.

Add the clips to the movie
1. Click the clip viewer tab (K). Drag the clips from the shelf (J) to the clip viewer. To select multiple clips hold down the shift key

and click additional clips on the shelf.
2. The clip viewer shows the clips in the order they’ll appear when you view the movie. Choose edit menu > select none. Drag to

position the video clips in sequential order in the clip viewer. The clip stays where you’ve dragged it when you release the mouse
button.

3. To see the clips play in the new sequence, press the home button (E) in the playback controls, then press the space bar.

Delete extra video
1. Click and drag just below the scrubber bar (B) under the iMovie monitor. The crop markers appear.

You use these crop markers to select video.
2. Drag the beginning crop marker to the frame in which you wish to begin your deletion. To move the crop marker in small incre-

ments, click the crop marker and use the arrow keys on your keyboard.
3. Drag the end crop marker to the frame in which you wish to end your deletion.

IMPORTANT: After the crop markers have been set, don’t click anywhere else in the iMovie window or you’ll lose the video
selection.

4. Choose edit menu > clear. The part you selected is deleted. An additional clip appears in the clip viewer. It contains the part of
the clip that occurs after the part you deleted. Remember if you make any mistakes you can choose undo from the edit menu.
You can undo up to 10 prior actions (before you quit or save the movie).

Creating still-image clips
To create a still-image clip from video:
1. Select the clip that contains the picture you want to use.
2. Drag the playhead until the picture you want to use is showing in the iMovie monitor.
3. Choose edit menu > create still clip. The default duration of a still-image clip is 5 seconds. To change the duration select it and

type a new duration in the time field at the top of the clip viewer or the timeline viewer.

Splitting a clip into two clips
You can split a single clip into two clips. This is particularly useful if you want to keep an unused section of a clip on the shelf
for later editing, or if you need to insert a title in the middle of a clip.

To split a clip:
1. Select the clip.
2. Move the playhead to where you want to split the clip.



3. Choose edit menu > split video clip at playhead. The split-off segment of your clip (For example clip 05) is named clip 05/1.

Replacing video
1. Click outside the clip viewer to deselect all clips.
2. Select the clip that you want to insert.
3. Choose cut or copy from the edit menu.
4. Position the playhead at the point you want the replacement to begin. The frames that follow the playhead will be replaced (up

to the length of the video you are inserting, regardless of what is selected in the movie).
5. Choose Advanced menu > paste over at playhead.

If you want to select the frames you replace, do this to replace video:
1. Select the video that you want to insert.
2. Choose copy or cut from the edit menu.
3. Use the crop markers to select the frames of video that you want to replace. If the video you’re inserting is longer than the selec-

tion, the excess video at the end of it is not pasted. If the video you’re inserting is shorter than the selection, the extra space left
at the end becomes a black clip (if a black clip appears select it and delete it if it’s unwanted). If the selection is a still image, the
extra space is filled with the still image.

4. Choose advanced menu > paste over.

Adding transitions
Transitions smooth the cuts between scenes and add visual appeal. You can put a transition at the beginning or end of a movie,
or between two clips.

To add a transition to a clip:
1. Click the transition button.
2. Select a transition in the transitions panel.
3. Use the speed slider to modify the speed of the transition into or out of the clip. Slower transitions take more time to render.
4. The push transition gives you arrows to choose the transition direction.

This is not available for some transitions.

5. Drag the transition from the transitions panel to the desired location in the clip viewer. A transition icon appears
between the clips, and a small progress bar appears under it. When the progress bar disappears, the rendering is done. You can
continue editing while a transition is rendering. If the rendering process stops before it is finished you may have clicked in a text
field. To let the rendering finish, click outside the text field.

Adding video effects
To apply video effects to your movie:
1. Click the effects button.
2. Select the video you want to apply the effect to.
3. Select a video effect in the effects panel.
4. Adjust the effect by using any sliders that appear in the panel (effects in slider sets the time that the effect takes to gradually

appear, the effects out slider sets the time it takes to gradually disappear).
5. You can preview your effect by clicking the preview button.
6. Click apply.

When you use an effect, iMovie applies the effect to your movie project but leaves the original footage untouched on your hard
disk. If you want to save hard disk space and you’re sure you want to keep an effect, you can delete the copy of the original
footage. To delete the original footage from your hard disk click commit. When you click commit, you can no longer change or
remove the video effect. If you change your mind after clicking commit choose edit menu > undo.

Adding titles (text)
A title lets you add descriptive text, such as credits, to your movie. You can choose from a variety of styles, fonts, and colors,
and you can edit titles after creating them. You can place a title over a section of a clip or create it as a separate clip with a black
background.



To add a title to your movie:
1 If you want the title to appear over a clip, click the clip in the clip viewer or the timeline viewer.
2. Click the titles button.
3. Select a title style from the list in the middle of the titles panel.
4. Type the text for your title into the text field or fields at the bottom of the titles panel. For some titles, such as centered multiple,

you can create more text fields by clicking the + button. You can reposition title fields by dragging them.
5. To speed up or slow down the titling effect, adjust the speed and/ or pause sliders. If there is a pause in the title style you chose,

use the pause slider to control the duration of the pause. The speed slider controls how many seconds the title lasts, and there-
fore how fast the title movement occurs. A slower title speed takes more time to render onscreen, but you can continue working
while it is rendering.

6. To put the title over a black background, select the over black checkbox. To make the title appear over the clip you selected in
step 1, leave the over black box unchecked.

7. To customize the text: Click the color box to choose a text color. Choose a font for your title from the font pop-up menu. Use
the text size slider to adjust the text size.

8. If the title scrolls, you can change the direction it scrolls. To change the scroll direction, click a direction button.
9. Drag the title from the list in the middle of the titles panel to the clip viewer. If you want the title to appear over a clip, place it

before that clip. A title icon appears between the clips, and a small progress bar appears under it. When the progress bar disap-
pears, the rendering is done. You can continue editing while a transition is rendering. If you want a title to appear in the middle
of a clip you must split the clip into two clips at the point where you want to insert the title.

Recording a movie to DV tape
Once you have created a movie in iMovie, you can record the final movie to your DV camcorder or deck.
To record your movie to tape:

1. Connect your DV camcorder to your computer using a Firewire cable.
2. Put the tape you’ll record to in the DV camcorder.
3. Choose file menu > export movie.
4. Choose camera from the export pop-up menu.
5. Click export.

To preview the recorded tape in iMovie:
1. Set the mode switch to camera mode.
2. Use the playback controls to rewind and play your movie.

Convert the movie to a viewing format
When you’ve completed a movie, you’ll want to convert it to a viewing format so people can watch it without using iMovie.
You can save the movie as a Quicktime movie file for online viewing.

1. Choose the file menu > export movie.
2. Choose Quicktime from the export pop-up menu.
3. Choose web movie, small from the formats pop-up menu. This format creates a movie optimized for playback over the world

wide web.
4. Click export.
5. Name your movie and choose a destination for the file.
6. Click save.

For further assistance in iMovie
For further assistance in iMovie check out the iMovie tutorial or from the finder choose the help menu > mac help. Click the
home button in mac help then choose iMovie help. 



Extracting audio from a video clip
If a video clip already contains audio when you import it, you can extract the audio from the clip, then edit the audio and/or reuse it
elsewhere in the movie.

To extract audio from a video clip:
1. In the timeline viewer, select the video clip that contains the audio you want to extract.
2. Choose advanced menu > extract audio. The extracted audio appears in audio track 1.

When you extract audio, you copy (not remove) it from the video clip. (However,
iMovie turns the volume of the video clip all the way down when you extract the audio, so you won’t hear the audio in the original
video clip anymore.)

Using a microphone to record a voice clip
You can record your voice into your movie using a microphone connected to (or in) your computer.

To record a voice narration in your movie:
1. Make sure you’re using a USB microphone, plaintalk microphone, or a plaintalk microphone adapter. The microphone plugs in to

the sound input port on the back of your computer.
2. Open the sound control panel. Click the input tab.
3. For a built-in microphone, choose built-in mic. For an external microphone, select  external mic.
4. In iMovie position the playhead where you want the narration to begin.
5. Click the audio button.
6. Click the record voice button in the audio panel.
7. Speak into the microphone. Use the volume level meter (above the record voice button) to determine how loud you should speak.

For best results, keep the level between 50% and 75%.
8. To end the recording, click the stop button.

Adding sound effects to a movie
To add a sound effect:

1. Click the audio button.
2. Drag a sound effect from the list in the audio panel to the desired position on audio track 1 or 2 in the timeline viewer. You can

reposition the sound effect by dragging it.

To delete a sound effect from your movie:
• Select the sound effect and press the delete key.

To add your own sound effect clips to the list in the audio panel:
• Open the iMovie folder, open the resources folder, and place AIFF or MP3 audio files in the sound effects folder.

Recording audio CD music
To record audio CD music into your movie:

1. Click the audio button.
2. Insert the audio CD into your computer’s CD-ROM drive. If your audio CD automatically starts playing through your computer’s

speaker, stop it by clicking the play button on the audio panel.
3. Select a track in the audio panel and do one of the following:

• Drag the audio CD track from the audio panel to audio track 1 or 2 in the timeline viewer.
• Click the record music button on the audio panel to start recording music into your movie. To end recording, click the stop button.

Using iMovie for audio



Muting and adjusting the volume of clips and sound effects
You can adjust the volume of individual audio and video clips and sound effects in a movie. This is important when you want to
make sure background sounds don’t overpower important foreground sounds, such as voice narration.

To adjust the volume of an audio clip or sound effect:
•  In the timeline viewer, select an audio clip, a sound effect, or a video clip that contains audio, and adjust the clip volume slider.

To mute all audio in a video or audio track:
•  Deselect the small checkbox at the right end of the track in the timeline viewer. When you export the movie, the muted 

audio is not saved or recorded with the rest of the movie.

To make audio fade in and out:
•  Select the clip in the timeline viewer and click the fade in and/or fade out boxes.

To adjust how long an audio fade lasts:
•  Double-click the clip and specify the fade duration in the clip info dialog box.

For further assistance in iMovie
For further assistance in iMovie check out the iMovie tutorial or from the finder choose the help menu > mac help. Click the
home button in mac help then choose iMovie help. 



Exporting your iMovie
Recording a movie to DV tape
To record your movie to tape:

1) Connect your DV camcorder to your 
computer using the FireWire cable.

2) Put a tape into the camcorder that you want
to record your iMovie on.

3) Choose > Export (From the File menu)
4) Choose > camera (From the “Export to” 

pop-up menu)
5) Choose > Export

Saving a movie as a QuickTime file
To save your movie as a QuickTime file:

1) Choose > Export (From the File menu)
2) Choose > QuickTime (From the “Export to”

pop-up menu)
3) Choose > A movie format (From the 

Formats pop-up menu)*
4) Choose > Export
5) You’ll then have to name your file and 

choose a destination for the file.
6) Choose > Save 

*About the QuickTime movie formats
The Formats pop-up menu contains these
formats:

Email Movie, Small
This creates a movie file optimized for
sending over email.  In order to view the
movie you need to have QuickTime 4.0
or later.

Web Movie, Small
This creates a movie for playback over
the World Wide Web.  You also need
QuickTime 4.0 or later.  But, you can
check the “QuickTime 3.0 compatible”
box instead to view with the earlier
version of QuickTime.

Streaming Web Movie, Small
This would allow you to post the movie
on a QuickTime Streaming Web server.



CD-ROM Movie, Medium
This creates a movie optimized for
playback from slower CD-ROM drives.

Full Quality, Large
This creates a high-quality movie.  Using
this format you preserve the most data
possible.  You would use this format for
importing your imovie into other
applications.

Expert
This format is used for creating custom
QuickTime settings.  Also custom
Internet Settings.

Placing your QuickTime imovie into
other Applications

Opening your QuickTime Movie in Power Point:

1) Choose > Insert > Movies and Sound 
2) Choose > Movie from Gallery
3) Select the movie you would like to put into 

Power point.
4) Use the Movie Tool Bar to navigate through 

your movie.

Opening your QuickTime Movie in Acrobat PDF
Format:

1) Select > The Movie Tool
2) Drag open a rectangle with the movie Tool.
3) The Movie Properties Box will appear when

you release the mouse.
4) Choose the settings you wish to have.
5) Click > Save preferences.
6) Click > OK
7) You can play your QuickTime imovie by

selecting the image from the PDF
Document.

Exporting your iMovie



Opening your QuickTime Movie in Director:

1) File > Import
2) Under the Import Files into “internal” menu

go to “Show.”
3) Select > QuickTime
4) Choose > Import
5) To play your QuickTime movie in Director 

you are going to double click the cast 
member in the “Internal Cast” window. 

Exporting your iMovie
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